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1. Introducing DSL Turbo 900

Introducing
DSL Turbo 900

1.1 Overview

Congratulations on your purchase of DSL Turbo 900!

DSL Turbo 900 is an External Bridge Modem that uses the latest communication
technology, ADSL (Asymmetric Digital Subscriber Line) to offer faster and
uninterrupted Internet access.  It allows use of real-time, interactive multimedia
and broadcast-quality for services such as video-on-demand, collaborative
computing and distance learning.

DSL Turbo 900 is capable of data rate in both Full-Rate and G.Lite, with Full Rate
transmission at up to 8 Mbps downstream, 640 Kbps upstream1 and G.Lite
transmission at up to 1.5 Mbps downstream, 512 Kbps upstream1.  Major features
include the following:

ADSL Protocols Support
To ensure the broadest customer reach, DSL Turbo 900 features multiple data
encapsulation formats for DSL transport over ATM PVCs, including the widely
supported ADSL protocol RFC 1483 (Ethernet Over ATM).

Compatibility (Interoperability)
Multimode ADSL support:  ANSI T1.143 Issue 2, ITU-T G.992.1 (G.dmt) and
G.992.2 (G.Lite).  DSL Turbo 900 uses discrete Multi-tone (DMT) line encoding
scheme which is also used by major ADSL equipment manufacturers,  thus further
guarantees interoperability with network service providers worldwide.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

This section gives a brief introduction of DSL Turbo 900 features and
its specifications.

1 The actual downstream and upstream rates will depend on the service package offered by your
ADSL Service Provider.
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1. Introducing DSL Turbo 900

ADSL Receive LED
(RX)
Lights up when the
ADSL Line is receiving
data.

Ethernet Activity LED (ACT)
Lights up when the Ethernet is
transmitting/receiving data.

ADSL Status LED (LINK)
Lights up when the ADSL
Line is established.

Power LED (PWR)
Lights up when Power
switch is pressed ON.

Ethernet Link LED (LINK)
Lights up when the Ethernet link is
established.

ADSL Transmits LED (TX)
Lights up when the ADSL Line is
transmitting data.

1.2 DSL Turbo 900 Features

1.2.1 Front View
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1. Introducing DSL Turbo 900

Power Connector (DC IN)
To connect to your Mains supply

Power Switch (PWR)
To power on or off the modem.
I - indicates ON position
O - indicates OFF position

Ethernet Jack (ETHERNET)
10Base-T Ethernet jack (RJ-45) to connect
to your Ethernet card

Serial Port (SERIAL)
9-pin serial port for local network management

Line Jack (LINE)
Telephone jack (RJ-11) to connect to the
ADSL Line

Phone Jack 2 (TEL)
Telephone jack (RJ-11) to connect to the
Telephone Handset

2 This optional connection provides easy access to your Telephone set while working near the
modem.

1.2.2 Rear View
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1. Introducing DSL Turbo 900

1.3 Knowing Your Cables

To ensure that you are using the correct cables for the modem, go through the
following table on the cable types, required for the corresponding jacks.

Jacks Types of cables required

ETHERNET RJ-45 UTP Category 3, 4 or 5 Crossover cable

SERIAL DB-9 Straight cable

LINE RJ-11 cable

1.3.1 RJ-45 UTP Ethernet Cable

RJ-45 cable is used for connection to your Ethernet card.  It acts as a tranmission
media between your Ethernet card and your modem.  One end is connected to the
Ethernet jack (ETHERNET) on your modem and the other end to your Ethernet card.

1.3.2 RJ-11 Cable

RJ-11 cable is used for connection to the ADSL line.  It provides a connection from
your modem to your ADSL Provider.  One end is connected to the Line jack (LINE)
on your modem and the other end to your Telephone Wall Socket.
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2. Before You Begin

2.1 Package

Ensure that you have the following items in your DSL Turbo 900 package.  For any
missing items, please contact your dealer immediately.

Before You Begin
This chapter contains information that you need to know before

setting up your modem.  It is important that you go through them.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

DSL Turbo 900 DSL Turbo 900
Installation CD

DSL Turbo 900
User’s Manual

Power adapter

UTP Crossover
Ethernet cable (RJ-45)

Telephone cable (RJ-11)

Power cable
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2. Before You Begin

2.2 Minimum System Requirements

Make sure that your computer meets the following requirements before you start
your setup.

• Pentium MMX 233MHz with Ethernet card that is installed with TCP/IP Protocol
(For video streaming, Pentium II 300MHz or above is recommended)

• A Serial Port

• A Crossover Ethernet Cable

2.3 Operating Environment

For optimum performance, ensure that DSL Turbo 900 operates within the following
operating environment.

2.3.1 Temperature

Operating : 10o to 45 o Celsius
50 o to 113 o Fahrenheit

Non-Operating : -25 o to 70 o Celsius
-13 o to 158 o Fahrenheit

2.3.2 Humidity

Operating : 30% to 80% Relative Humidity (Non-Condensing)
Non-Operating : 10% to 95% Relative Humidity (Non-Condensing)

2.4 Safety Precaution

• Switch off the modem and adapter when the modem is not in use.

• During times of lightning/thunderstorms, do not use the modem.

• Keep the modem away from water and direct sunlight.

• Do not introduce any foreign material to the modem through the ventilation
slits (e.g. by dropping foreign items or poking into the slits).
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3. Setting Up DSL Turbo 900

3.1 Setup Overview

The following gives an overview of DSL Turbo 900 setup.

Setting Up
DSL Turbo 900

This chapter contains information on setting up DSL Turbo 900.
Verification steps are also included to ensure correct connections.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Telephone 2Telephone 1

PC

DSL Turbo 900
Micro-Filter 3

Power
adapter

LINE

The Mains
Supply

10Base-T
(UTP Crossover
Ethernet cable)

LINE

3  The Micro-Filter can be
purchased separately from

SingTel Magix.
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3. Setting Up DSL Turbo 900

3.2 Connecting DSL Turbo 900

Please carry out the following steps to connect your modem to your computer.

Power off your computer and any connected devices before installing
your modem!

3.2.1 Connecting the UTP Ethernet Cable

Connect one end of the Ethernet cable to the ETHERNET jack on DSL Turbo 900
and the other end to the Ethernet card on your PC.

Rear view of a PC

UTP Crossover
Ethernet cable

Ethernet card

ETHERNET

Rear view of DSL
Turbo 900
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3. Setting Up DSL Turbo 900

3.2.2 Connecting the Telephone cable (RJ-11)

Connect one end of the telephone cable to the LINE jack on your modem and the
other end to your Telephone wall socket.

Telephone
wall socket

Telephone
cable

LINE

Rear view of DSL
Turbo 900

3.2.3 Connecting to a Telephone Set

This connection is optional.  The TEL jack provides easy access to your Telephone
set while working near the modem.

Connect the Phone cable to the TEL jack on your modem.

Telephone set

Phone cable
TEL

Rear view of DSL
Turbo 900



14 ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

3. Setting Up DSL Turbo 900

3.2.4 Connecting to the Power Mains

Connect the connector of the Power adapter to the DC IN on your modem.

Attach the jack of the Power cable to the Power adapter as shown, and the Power
plug to the Power Mains.

Power adapter

Power Mains

Power cable

DC IN

Rear view of DSL
Turbo 900
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3. Setting Up DSL Turbo 900

3.3 Verifying Your Connections

To verify the connections that you have done,

Power on DSL Turbo 900
i) Power on the Switch at the Mains Supply.
ii) Power on the Switch on DSL Turbo 900.

Observe the following LEDs on your modem:

3.3.1 Power LED (PWR)

3.3.2 Ethernet Link LED (LINK)

You should see this
Power LED lights up.

You should see this
Ethernet Link LED
lights up.

If your Power LED does not
light up, check that:

i) the Mains Supply is
powered on and the Power
switch on the modem is at
‘I’ position.

ii) the connection is carried
out as described in section
3.2.4 - Connecting to the
Power Mains.

If your Ethernet Link LED
does not light up, check that:

i) the connection is carried
out as described in section
3.2.1 - Connecting the UTP
Ethernet Cable.
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3. Setting Up DSL Turbo 900

3.3.3 ADSL Status LED (LINK)

This LED will start blinking,
trying to establish a
connection.  Once the
connection is established, this
LED will remain lit.

If your ADSL Status LED does
not light up, check that:

i) the Mains Supply is
powered on and the Power
switch on the modem is at
‘I’ position.

ii) the connection is carried
out as described in section
3.2.2 - Connecting the
Telephone cable (RJ-11).

If the mentioned 3 LEDs all light up, it means that your modem are successfully
connected.

3.3.4 Phone connection

If you have connected a
Telephone set to your modem,
pick up the handset of the
Telephone.  You should hear the
normal dial-tone.

If you do not hear the normal dial-tone of a
telephone, check that the connection is done
as described in section 3.2.3 - Connecting
to a Telephone Set.  If your connections are
correct, it may be due to a faulty phone cable
that you are using.

This completes the connections for DSL Turbo 900.  For Windows® 98 and Windows®

2000 users, please proceed to the Chapter 5 on Installing the Client Software.  For
Windows® 95 users, please proceed to the following chapter to configure your
Ethernet card before proceeding to chapter 5.
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4. Configuring Your Ethernet Card

Configuring Your
Ethernet Card

(For Windows® 95 users only)

This chapter guides you on how to configure your Ethernet card that
is installed on your computer to work with DSL Turbo 900 for

Internet.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Power on your computer.1
2 From your Windows desktop, right-click on the Network Neighborhood

icon.  Select Properties.

From the Configuration tab,
check for the listing of TCP/
IP (as shown on your left).

If TCP/IP is listed, you may
proceed to the chapter 5 to
install the client software.

If TCP/IP is not listed,
continue with the following
configurations.

3
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4. Configuring Your Ethernet Card

From the Configuration tab, select Realtek RTL8029(AS) PCI Ethernet
NIC and click Add.

At the Select Network Component Type prompt, select Protocol and click
Add... .

4

At the Manufacturers
field, select Microsoft.
At the Network
Protocols field, select
TCP/IP.  Click OK.

5
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4. Configuring Your Ethernet Card

You will be prompted for your Windows 95 CD-ROM/diskettes.  Insert
your Windows 95 CD-ROM/diskettes in your CD-ROM Drive/Floppy Disk
Drive and click OK.6

7 Follow any on-line instructions.  If you are prompted with DHCP prompt,
asking if you want to see future DHCP messages, click No.

This completes the configuration for your Ethernet Card.  You may now proceed to
chapter 5 to install the Client Software.
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4. Configuring Your Ethernet Card

This page is intentionally left blank.
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5. Installing the Client Software

Installing the
Client Software

This chapter guides you on how to install the Client Software,
required for DSL Turbo 900 to connect to Singtel Magix Service.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

1 From the root directory of your DSL Turbo 900 Installation CD, locate the
file setup.exe.  Double-click on it.

2 The following window will be prompted.

3 At the License Agreement prompt, click Next.

Click Next.

5.1 Installing the Software

The installation procedures for Windows ® 9x and Windows ® 2000 are
similar.  Follow closely to the online instructions.  (The following illustrations
are based on Windows ® 2000.)
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5. Installing the Client Software

4

Enter your name and
the company that you
are working for and
click Next.

Accept the default
destination location and
click Next.

Accept the default
program folder name
and click Next.

5

6
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5. Installing the Client Software

7

Click Finish to
complete the software
installation.

8
Click OK to define a
connection entry.

9

At the Entry name field,
type in Magix and click
Next.
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5. Installing the Client Software

11

10

Enter your username and
password as given by
Magix and click Next.

Click Finish to complete
the settings for Magix
connection entry.

12

At the prompt, ensure that
you have selected Magix
for connection and click
Exit.
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5. Installing the Client Software

From your Windows desktop, locate the Magix shortcut icon .

Double-click on the icon.

(The Magix icon is automatically generated when you have completed your Client Software
Installation as described in section 4.1.)

5.2 Establishing the Magix Connection

1

2 Allow some time for system to establish a connection.

Upon successful connection, a prompt indicating Call established will
be displayed briefly.

You will also see the Magix connection icon
at the corner of your Windows taskbar.

3

Click Cancel at this prompt.

For Windows ® 9x users, you may be prompted for your username and
password when you double-click Magix icon.  Enter the username and
password as given to you by Magix and click Connect .
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5. Installing the Client Software

5.3 Checking the Connection Information
To check the connection information, right-click on
the Magix connection icon at the corner of your
Windows taskbar.  Select Status.

To disconnect from Magix, right-click on the Magix
connection icon.  Select Disconnect.  A cross (X)
appears on top of the icon, indicating that you are
disconnected from Magix.

5.4 Disconnecting from Magix

Select �Do not show the Internet Connection
wizard in the future� and click Yes.

Refer to chapter 6 for web browser
configurations.

(The details shown are examples only.)

4

The connection status
(Condition), session connection
time (Duration) and so on will be
displayed as illustrated.  Click OK
to close.
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5. Installing the Client Software

1
If you need to change the entry settings, click
Start > Programs > Magix Client > Magix RAS
Session Manager.

2

5.5 Changing of Entry Settings

Click Edit.

Make your
changes and click

OK.
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5. Installing the Client Software

5.6 Changing of Your Magix Password

To change your Magix login password, you need to make changes at both the
Client software and at the Magix website.

5.6.1 Changing Magix Password at Magix Website

Launch your Internet Explorer/Netscape Navigator/Netscape
Communicator browser.  You must be connected to the Internet Service.
(See section 5.2 - Establishing the Magix Connection.)

Type in �http://smtp.magix.com.sg� in your browser�s address bar.  You
should see a similar page as shown below.

1
2

Select �Change Password for Magix� option.  You will be prompted the
Change Password page.  Follow the online instructions to complete the
change of password at Magix website.

You must  enter your password in UPPERCASE, with at least 5
characters and one numeric.



29○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

5. Installing the Client Software

5.6.2 Changing Magix Password in the Client Software

1
From your Windows taskbar, click Start >
Programs > Magix Client > Magix RAS Session
Manager.

2

Click Edit.

Overwrite your existing
password with the new

one and click OK.

This completes the change of password.  You may now proceed logging on to
Magix with your new password.
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5. Installing the Client Software

This page is intentionally left blank.
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6. Web Browser Configurations for Magix

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

6.1 Configuring Internet Explorer v3.02 to access
Magix Service

Right-click on the Internet Explorer icon on your Windows desktop.  Select
Property.

Click the Navigation tab.  At Page prompt, enter the Start Page Address
as http://www.magix.com.sg and click OK.

Double-click on the Internet Explorer icon to launch your browser.

From the browser menu, click Favorites and select Add to Favorites....

Web Browser Configurations
for Magix

This chapter helps you configure your Web browser for Magix.  It
contains instructions for IEv3.02, IEv4.0, IEv5.0, Netscape Navigator

Gold v3.0 and Netscape Communicator v4.02.

1
2
3
4

5 No proxy setting is required.
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6. Web Browser Configurations for Magix

6.2 Configuring Internet Explorer v4.0 to access
Magix Service

Double-click on the Internet Explorer 4.0 icon on your Windows desktop
to launch your browser.

From the View menu, select Internet Options.

Select the General tab and enter Home Page Address as
http://www.magix.com.sg.

Select the Connection tab.  Under Connection option, select �Connect
to the Internet using a local area network�.

Under Proxy server option, ensure that proxy server is unchecked and
no proxy settings are configured as shown.  Click OK.

1
2
3
4
5



33○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

6. Web Browser Configurations for Magix

6.3 Configuring Internet Explorer v5.0 to access
Magix Service

Double-click on the Internet Explorer 5.0 icon on your Windows desktop
to launch the browser.

From the Tools menu, select Internet Options.

Select the General tab, enter Home Page Address as
http://www.magix.com.sg.

Click the Connection tab.  Select Never dial a connection as shown
below.

1
2
3
4

Click LAN Settings... button.

Disable automatic configurations and proxy server settings as shown
on the following page.

5
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6. Web Browser Configurations for Magix

Click OK.

6.4 Configuring Netscape Navigator Gold v3.0 to
access Magix Service

Double-click the Netscape Navigator icon on your Windows desktop.

Under the Options menu, select General Preferences... .

In the Startup section, type in the Home Page Location as
http://www.magix.com.sg and click OK .

No proxy settings is required.

1
2
3
4
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6. Web Browser Configurations for Magix

6.5 Configuring Netscape Communicator
(v4.02 and above) to access Magix Service

Double-click the Netscape Navigator icon on your Windows desktop.

From Edit menu, select Preferences� .

In the Category section, double-click Navigator.  In the Home Page
section, enter http://www.magix.com.sg.

In the Advanced section, double-click Proxies.

Ensure that the �Direct connection to the Internet� is selected.  Click
OK.

1
2
3
4
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6. Web Browser Configurations for Magix

This page is intentionally left blank.
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7. Email Configuration for Magix

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

7.1 Setting Up Outlook Express for Magix Service

7.1.1 Setting Up Outlook Express to Access Internet Mail

The following procedures are recommended for Magix Service subscribers who
want to use Outlook Express to access their Internet mail.

With Outlook Express installed, double-click the shortcut icon on your
Windows desktop.

From the Tools menu, select Accounts.

Email Configurations
for Magix

This chapter helps you configure Magix on Outlook Express and
Newsgroup Services for Netscape Communicator v4.05.

1
2
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7. Email Configuration for Magix

From the Mail tab, click Add, Mail... .

In the Display name text box, key in your name to be used for outgoing
messages and click Next.

Enter your e-mail address as shown in the example below and click
Next.

3

4
5
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7. Email Configuration for Magix

Select POP3 type server to be your incoming mail server.  Enter the
following information:

Incoming mail server : smtp.magix.com.sg
Outgoing mail server : mail.magix.com.sg

Click Next.

Enter your user ID and password.  The figure below is an example of
how it should be done.

Click Next.

6

7
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7. Email Configuration for Magix

Click Finish to save the settings.

To verify the settings for the new mail account, select on the account
and click Properties button.

8

9

10
Click Close to exit.

In order for the new setting to take effect, please exit and re-enter
Outlook Express.
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7. Email Configuration for Magix

To start a new message, from the toolbar, click Compose Message.
To send and receive e-mails, click Send/Recv.

A window will pop-up to display the connection progress, with the
task status displayed at the bottom of the window.  (It can take a few
minutes to complete the sending and receiving operations.  )

To view incoming mails, double-click the Inbox icon on your Windows
desktop.

11

12
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7. Email Configuration for Magix

7.1.2 Setting Up Outlook Express to Access Newsgroup

In Outlook Express, from the Tools menu, select Accounts.  When the
Internet Accounts window appear, select the News tab.

From the News tab, click Add, News to proceed for setting up newsgroups
access.  (This is similar to the previous configuration for the internet
mail access.)

Enter your display name as seen in the example below and click Next.

Enter your email address as shown below and click Next.

1
2

3
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7. Email Configuration for Magix

Enter the following information for the News(NNTP) server:
news.magix.com.sg.

Click Finish to save the settings.

4

5
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7. Email Configuration for Magix

7.2 Setting Up Mail and Newsgroup Services for
Netscape Communicator 4.05

7.2.1 For new users of Netscape Communicator and those who
just installed Netscape Communicator

Start up Netscape Communicator by double-clicking the icon from your
Windows Desktop.

You will be prompt to setup a new profile.  Click Next.

Enter your name and e-mail address in the given text boxes.  Click Next.

1
2
3
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7. Email Configuration for Magix

Enter your profile name and the directory where your mail will be stored
and click Next.

Enter your Outgoing [SMTP] mail server as mail.magix.com.sg.

Click Next.

4

5
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7. Email Configuration for Magix

Enter your Incoming Mail Server  as smtp.magix.com.sg.  Ensure that
the POP3 Mail Server type is selected.

Click Next.

Enter your News
(NNTP) server as

news.magix.com.sg
and Port as 119.

Click Finish to confirm
the settings made.

After completing
setup, Netscape
Mailbox can be

accessed by clicking
Messenger from the

Communicator menu.

6

7
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7. Email Configuration for Magix

7.2.2 For users setting up internet mail service on their existing
Netscape Communicator

Enter Netscape Communicator.  From the Edit menu, select Preferences.

In the Category field, select Mail & Newsgroups, Identity.  You are only
required to fill in your user ID and E-mail address.

1

2
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7. Email Configuration for Magix

Select Mail &
Newsgroups, Mail

Servers.

Fill in your Outgoing
mail server and user

id.

3

Next, click Mail & Newsgroups, Newsgroup Servers.4
It is recommended

that new users use the
default discussion

group (news) folder
provided.

To save your
settings, click OK.

You may access your Netscape mail by clicking Messenger from the Communicator
menu.
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8. Uninstalling the Client Software

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Uninstalling the
Client Software

This chapter helps you uninstall the Client software used for Magix
Service.

From your Windows taskbar, click Start > Settings > Control Panel.
Double-click on the Add/Remove Programs icon.

Select Magix RAS Session Manager and click Change/Remove.  Follow
any online instructions to remove the software.  Upon completion, click
Close.

1
2
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8. Uninstalling the Client Software

This page is intentionally left blank.
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A. Technical Specifications

Technical Specifications
This chapter contains the technical specifications of DSL Turbo 900.

The information may be more useful for technically inclined users.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

A-1 Main Features

� Controller-based External ADSL Modem

� UTOPIA Specifications Level I and Level II compliant

� ANSI T1.413 issue 2, ITU-T G.992.1 (G.dmt) and G.992.2 (G.lite) compliant
� Using Discrete Multi-Tone (DMT) line encoding scheme

� Full Rate transmission at up to 8 Mbps downstream and 640 Kbps upstream1

� G.lite transmission at up to 1.5 Mbps downstream and 512 Kbps upstream1

� Rate Adaptive modem at 32 Kbps steps

� Up to 18,000 ft loop reach

� Flash ROM upgradable for future feature enhancement

� RFC1483 Bridged (Ethernet Over ATM) protocol stack support
� Remote management through Telnet console access

� TFTP Software update

• Spectral compatibility with POTs

1 The actual downstream and upstream rates will depend on the service package offered by your
ADSL Service Provider.
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A. Technical Specifications

A-1-1 ADSL Chipset

Using ST Microelectronics Ascot solution :

� Virata VC8410 (Helium) � ATM Communications Controller
� STLC70135 - ADSL DMT Modem and ATM Framer

� STLC70134 - ADSL Analog Front End

� 4MB Dual-ported SDRAM

� 1MB Flash ROM

A-1-2 Virata VC8410 (HELIUM) � ATM Communications
Controller

� Built-in 48MHz ARM-based Protocol and Network Processor

� UTOPIA Level I v1.0 and Level II interface

� 10BaseT Ethernet interface with integrated PHY
� Dual-ported SDRAM Interface

� ATM Cell Header Filter

� STLC70135 Configuration Register Interface

� +3.3-volt, 208-pin PQFP

A-1-3 STLC70135 ADSL DMT MODEM & ATM FRAMER

� ANSI T1.413 Issue 2 standard DMT modem with embedded ATM Framer

� ITU-T G.992.1 (G.dmt) and G.992.2 (G.lite) compliant
� Standard Utopia Level I and Level II ATM Interfaces

� DMT Modulation up to maximum of 256 tones (14 bits)

� ADSL/ATM cell-specific Framing and Deframing

� Rotor and Frequency Domain Gain Correction and Equalization
� Performs DMT Modulation, Demodulation, Reed-Solomon Encoding, Bit

Interleaving, and 4D Trellis Coding

� 3.3-volt, 144-pin PQFP
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A. Technical Specifications

A-1-4 STLC70134 ADSL Analog Front-end

• Integrated Analog Front End (AFE) for ADSL

• High sampling rate at 8.832 MHz for both ADC and DACs

• Two (2) 12-bit DACs, One 13-bit ADC

• Differential Analog Input/Output

• Accurate continuous-time low pass filters for channel filtering

• 3.3-volt, 64-pin LQFP

A-1-5 ADSL Software Support

• ATM Transmission Convergence (TC) layer

• ATM Layer with Traffic shaping

• AAL ATM Attributes - AAL5

• RFC-1483 Bridged (Ethernet Over ATM)

• RFC-2516 PPP over Ethernet (Supported via Optional Software)

• PPTP Tunneling Protocol (when available)

• UNI 3.0, 3.1 and UNI 4.0 ATM Signaling (support for SVCS)

A-1-6 Platform Support

• Windows® 95, 98 and Windows® 2000 (with an Ethernet Card installed)

A-2 External Connectors

• 1 x  RJ11 Telephone socket for ADSL line
• 1 x  RJ11 Telephone socket for Telephone Handset
• 1 x RJ45 for 10Base-T Ethernet
• 1 x MiniDIN Power Connector
• 1 x On/Off Power Switch
• 9 pin Serial Port for local management
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A. Technical Specifications

The specifications herein are subject to change without prior notifications.

A-3 LED Indicators

� 1 x  Power LED
� 1 x Ethernet Link Status LED

� 1 x Ethernet Activity LED

� 1 x ADSL Receive LED
� 1 x ADSL Transmit LED

� 1 x ADSL Link Status LED

A-4 Environmental

A-4-1 Temperature

Operating : 10o to 45 o Celsius
50 o to 113 o Fahrenheit

Non-Operating : -25 o to 70 o Celsius
-13 o to 158 o Fahrenheit

A-4-2 Humidity

Operating : 30% to 80% Relative Humidity (Non-Condensing)
Non-Operating : 10% to 95% Relative Humidity (Non-Condensing)

A-5 System Requirements

Pentium MMX 233MHz with Ethernet card that is installed with TCP/IP Protocol (For
video streaming, Pentium II 300MHz or above is recommended)
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B. Frequently Asked Questions

Frequently Asked Questions
This section provides answers to the commonly asked questions on

your ADSL modem.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

What is ADSL ?

ADSL, Asymmetric Digital Subscriber Line is a broadband communication
technology designed for use on regular phone lines.  It has the ability to
move data over the phone lines at speeds up to 140 times faster than the
analog modem available today.

Why is it called Asymmetric ?

It is called asymmetric because more bandwidth is reserved for receiving
data than for sending data.  This is useful because many users of the
Internet receive much more data than they send.

What are the benefits of ADSL over analog modems ?

Besides the high-speed advantage, ADSL connection is always on.  There
is no longer a need to log on and off, no more busy signals and no more
waiting for the connection to established - it is always there.  On top of
these, you can use the phone even when the data connection is on.  You
do not need to switch between surfing the Net and talking over the phone.

Will my modem constantly connect near the maximum speed  ?

At ADSL speeds, the limitations depend on the performance or load of
the ADSL Service Provider that you are trying to reach, as well as the line
condition specific to your location.
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B. Frequently Asked Questions

Can I connect to the �Magix Internet Services� everywhere I go?

No, you cannot.  You can connect to this service, only via ADSL phone
line enabled for the Magix Internet Services.

Can I run both dial-up modem and ADSL modem ?

Yes, but it is not recommended.  You may experience slowness during
surfing as well as incurring additional cost of maintaining two active
connections.

Do I need to use Micro-Filter when using ADSL ?

It is necessary to use Micro-Filter when the ADSL line is shared by other
telecommunication devices such as analog modem, telephone and fax
machine.  This is to effectively eliminate noise from the same line to
ensure optimum ADSL performance.

If the ADSL line is not shared by another telecommunicatin device, then a
Micro-Filter is not required.

Refer to section 3.1 - Setup Overview for the correct placement of the
Micro-Filters.

(The Micro-Filters can be purchased separately from SingTel Magix.)
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C. Troubleshooting Guide

Troubleshooting
This section provides a step-by-step solutions to problems that you

may encounter when setting up or using your ADSL modem.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

I am not getting any connection.  The modem Power LED lights up and
the ADSL Link LED keeps blinking.  (The ADSL Link LED does not remain
light up.)

Power off your modem and check the following:

i) Ensure that the Power adapter is tightly fitted into the DC IN.

ii) Check that the Telephone cable (RJ-11) is connected to LINE jack on
your modem and not to the TEL jack.

iii) Power on your modem.

If the problem still persist, please check with your ADSL Service Provider.

I am getting poor ADSL speed performance from my modem.

i) Ensure that the ADSL line is at least 10cm away from the Power adapter.
(see the following page for illustration.)

ii) Place your modem away from devices or appliances such as monitors,
exposed computer systems (with chassis covers removed) or another
modem which exhibit magnetic fields that may cause interferences to
your modem line.

iii) Ensure that Micro-Filters are used for phone sockets that are sharing
the same ADSL line.

If your modem speed or performance is still unsatisfactory, please contact
your ADSL Service Provider.
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be greater than 10cm

Power adapter

Telephone cable (RJ-11) - ADSL Line

Telephone wall
socket

Mains Supply

Rear view of
DSL Turbo 900

When I double-click the Magix  icon, an error message, �You have

already started a version of this program� appears.

Press <Ctrl><Alt><Del> simultaneously.  Select �RAS Session Manager�
and click End Task.  Try re-connecting again.

Nothing happens when I double-click the Magix  icon.  The Magix

connection  icon at the corner of the taskbar remains disconnected
(displaying a cross, X).

Press <Ctrl><Alt><Del> simultaneously.  Select �RAS Session Manager�
and click End Task.  Try re-connecting again.
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When I double-click the Magix icon on my desktop, an error message,
�User has no authorisation for this call� appears.

Make sure that you have entered the username and password as given
by Magix.  To verify,

i) From your Windows taskbar, click Start > Programs > Magix Client
> Magix RAS Session Manager.

ii) At the Magix RAS Session Manager prompt, ensure that you have
selected Magix at the drop-down list and click Edit... .

iii) From the Authentication section, ensure that your username is correct
and that the password are in UPPERCASE.  (If you are unsure, overwrite
the existing one).  Click OK to save changes.

When I double-click the Magix icon on my desktop, an error message,
�Request service is unknown� appears.

Make sure that you have entered the username and password as given
by Magix.  To verify, carry out the instructions as described in the previous
question: When I double-click the Magix icon on my desktop, an error
message, �User has no authorisation for this call� appears.

Another reason could be that you are not registered for the listed service.
Subscribe to the service and try again.
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D. Technical Support

Technical Support

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Aztech Sales Enquiries

Hotline : (65) 741 7211 (Marketing and Sales Department)
Email : sales@aztech.com.sg
Fax : (65) 749 1198

Working Hours : Monday to Friday - 0900 to 1800
Saturday/Sunday/Public Holidays - Closed

Aztech Technical Support
(c/o AVS Computer Services Pte Ltd 4)

Hotline : (65) 742 9633
Email : service@avscs.com
Fax : (65) 742 9010

Working Hours : Monday to Friday - 0900 to 1800
Saturday/Sunday/Public Holidays - Closed

4 AVS Computer Services Pte Ltd is Aztech authorised Customer Service Center.

Technical Support Considerations

Majority of enquiries can be resolved efficiently.  However, there may be cases
when it is beyond our technical support to assist you.  We may not be able to assist
you in:

� Hardware conflicts

We will try to discover them and make suggestions but we are unable to
repair them over the telephone.
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� Software conflicts

Removal of other software and reinstalling our software may be the only
solution.

� O/S problem

If you encounter problems like fatal exception or illegal operation, kindly
refer to your PC vendor.

� Modifications made to your software

Our technical support officers are trained to support the software we provide
as part of our service and they are knowledgable about a wide range of other
programs.  However, we are unable to support software that has been
modified.
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Notes



P/N:  040-5B2412-111
 Copyright Aztech Systems Ltd, May 2000©


